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Editing

IN THIS CHAPTER:
•	 Group Editor
•	 Topology Editor
•	 Vector Eraser tool
•	 Shears tool
•	 Camber Editor
•	 Adhesion Corrector
•	 Shift / Resize Polyline tool
•	 Bookmarks  - positioning tool
•	 Inspector tool
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Group Editor 

As appears from the name, this tool operates on groups of objects, but it changes their 
properties rather than shape. Object transfer to another layer,  duplication, change of 
attributes and Z-values, selection and marking of objects constitute  its field of application.

For example, it provides the fastest method to assign attributive data to one-type vector 
objects. 

Editing starts with selection of objects. It may be done in several ways:

•	Manual selection -it is enough to click an object with the mouse left button to include 
it into the group. If you click a selected object again it will be excluded. 

•	 Box selection - hold the left mouse button down, drag a box to select all the objects 
within it, and release the button. If you drag the box from left to right, only objects 
totally falling into its area will be selected; if you drag it from right to left, the objects 
crossed by its boundary will be also selected for editing. Several box selections may 
be done successively to enlarge the group and specifying of individual objects helps 
to correct its membership.

•	 Selection by a query - this option enables you to select all the objects meeting the 
requirements you have specified. These may be layer, object type, and additional 
conditions formed in the specialized field of the dialog box. You may mark the 
objects of the group for further successive review instead of their selection for editing.

•	 To deselect a group, use the Deselect command of the Group Editor submenu or 
“take” any other tool.

Apart from the layer and elevation (Z-value), change of selected objects’ features is 
possible if the objects are of the same type.

For group editing of attributive data, all the selected objects should be connected with the 
same table of attributes, i.e. they should be of the same type and belong to the same layer.

Group Editor’s submenu contains commands that can be applied to the selected objects. .

Hot key for selection of Group Editor is  Alt + «~».
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Commands of Group Editor submenu

Additional  menu of  
Group Editor

•	 Select objects
•	 Select objects by a query
•	 Unselect
•	Move
•	 Duplicate to another layer(s)
•	 Copy to the same layer
•	 Reverse sequence order of vertices in 
polyline(s)

•	 Convert to 3D polyline(s) 
•	 Edit attributes of selected objects
•	 Create a block out of a selected objects
•	 Delete selected objects

Group Editor submenu is an icon bar you can open by a right click within the program 
working window. The set of commands available from the submenu depends on the 
type of selected objects:

 Select objects

This mode enables you to change the group of selected objects - to include new or exclude 
some previously selected ones with the mouse left button or applying box selection. 

 Select objects by a query

Opens the Select Objects by a Query dialog box. Here you may specify the layer (layers) to 
select objects from, the type (types) of objects to be selected, and some specific selection 
criteria. It is possible to select or mark objects that meet selection requirements. The 
dialog box is discussed in detail below.

 Unselect

The command deselects all the selected objects

 Move

All selected objects are enframed by a box and may be moved with the mouse or arrow 
keys. To move objects with the mouse, hold down the left button inside the box and 
drag the group.

You may also move objects stepwise applying the keyboard - one stroke of an arrow key 
shifts the box per one screen pixel, so you may control exactness of the process with the 
help of zooming. To leave the mode, click the mouse right button, or stroke the Esc key.
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 Duplicate to another layer

The command opens the Select Layer for Duplicating dialog box where you specify the 
layer you want to duplicate (copy) the selected objects to. Duplication results will be 
invisible if layers of copies are under layers of originals. You may also copy objects to 
their own layer.

The command is useful when you create a vector layer - «mask», which will be used by 
the Rasterize vector data utility. It helps to «unload» data-saturated images.

 Copy to the same layer

The command allows you to substitute vectorizing of identical objects by positioning 
of copies. New objects are shifted a little relatively the initial one, selected, and Move 
mode is started automatically.

 Input/edit object attributes

The command is accessible if all selected vector objects are of the same type and ascribed 
to the same layer linked to the Database of your project.

It opens the Object Attributes dialog box. There may be written “Multiple selection” in 
some fields. It means that some selected objects have different attributive values in these 
fields. If you specify a new value there it will be assigned to all the members of the group..

You may change attributes in  explicitly editable fields only. Input of a new value in one 
field does not affect other fields including ones with “Multiple selection”.

 Create block

Block in Easy Trace is the main representation means for symbol objects. It may be used 
for example for check of attributes in Thematic view mode. 

Another field of block application is vectorizing of identical complex objects. You may 
vectorize one of them, convert it into a block and then input the block in all desirable 
positions. The blocks may be later exploded into composing entities.

To create a new block, select two or more objects, including one (only!) point. The point 
serves as the insertion point of the block; it is represented in the block by one screen pixel. 

The command opens the Parameters for Block Definition dialog box where you may 
specify block name and the layer it will be assigned to by default.

 Delete selected objects

The command deletes all objects currently selected with Group Editor.
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 Reverse sequence order of vertices in polyline(s)

The command changes direction (sequence order of vertices) of all selected polylines. It 
may be necessary to show direction of river current or represent lines of a complex form 
(fences, ravines, etc.) correctly.

Direction of a simple polyline may be controlled with the help of Line direction mode.

 Convert to 3D polyline(s) 

The command turns all selected polylines into 3D-polylines. Z-coordinates of the lines 
become elevation values for points in the corresponding 3D-polylines.  The command 
is accessible for polylines only.

 Convert to polyline(s)

The command turns all selected 3D-polylines into common polylines. Z-coordinate of 
the polylines will be equal to zero. The command is accessible for 3D-polylines only.

Parameter bar of Group Editor

Parameter bar of Group Editor

The set of fields in Parameter bar of Group Editor depends on the set of selected objects. 
If all selected objects are of the same type, the bar is identical to one of Editor of vector 
entities. For a nonuniform group, only the number of selected objects is shown. 

If all selected objects are blocks, the bar contains a special button    (Explode blocks). 
It divides selected blocks into original vector objects. 
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Select Objects dialog box at selection by a query

Select Objects dialog box of Group 
Editor at selection by a query

Object selection with the help of a query is probably the most flexible and effective way 
to form a group of objects for further check and editing. It helps to accomplish such 
non-trivial tasks as object classifying after automatic vectorizing, search of objects with 
wrong attributes, and group editing of attributive data. 

Besides, it provides convenient means of object marking for subsequent check and 
correction. Marked objects become accessible for quick review with prompt jumps from 
one object to another.

For quick navigation between marked objects, switch on the View Marked Objects 
mode. Use «F» and «V» keys to move from one object to another with simultaneous 
mark deletion.

Selection by a query is based on a combination of object features such as layer, type, 
geometrical and attributive characteristics. You may form arbitrary sets of selection 
criteria.

Use of selection by a query

Click Select button after criteria specifying to complete the operation. Several options 
are provided for object selection:

•	 Replace the current selection;
•	 Add to the current selection;
•	 Search among selected objects.

Selected objects may be marked for further review or unmarked with the help of Mark 
and Unmark buttons. 

Opened dialog box of selection by a query does not prevent use of other commands from 
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Group Editor submenu and Parameter bar. 

Selection conducting

Specify the set of layers to search for objects at first of all - just tick their names. 

Then specify the type of vector objects to be selected or marked in the Select objects of 
given type field. Number of objects meeting these two selection criteria will be shown 
immediately for every object type. It does not depend on the number of objects already 
selected with Group Editor.

The next step is detailing of selection criteria. Use the Attribute, Condition and Value  
fields to form a set of requirements, which selected objects should meet. There may be 
several conditions connected by logical operators AND or OR.

Specified selection conditions form a filter represented in a frame. If the frame is empty, 
selection will be based on object type(s) and layer(s) only.

Change or adding of selection conditions immediately affects the number of objects that 
meet the requirements. 

Forming of the set of selection criteria

The Attribute / Condition / Value group enables you to form and edit selection criteria. 
Specified conditions become active when you add them to the filter. To form a set of 
selection conditions, act as following:

1.	Select an attribute to base selection upon. This may be an object characteristic (length, 
number of vertices, closure), or a field of an attributive table.

Only attributes applicable to all objects are represented in the list if the group comprises 
objects of different types or different layers. 

2.	Select fitness condition for attribute values (greater, less, equal, etc.). The set of available 
conditions depends on the type of attribute.

3.	Select or input the value to compare attribute values with. It may be a number or a 
text string.

4.	Add the formed set of conditions to the filter.

5.	There may be more than one condition of object fitness for selection. If all of them 
should be met simultaneously, select «AND» option in the Connect clauses with field. 
If conformity with any of the conditions is sufficient for selection, choose «OR».

The following commands are provided for  filter forming and editing:

 Add - adds current values in the Attribute / Condition / Value fields to the filter.

 Delete - deletes the chosen condition from the filter. To choose a condition, just 
click it.
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 Modify - changes condition or value in the filter for one in the corresponding field.

Select-by-sample - forms selection criteria from attributes of the object you have 
specified in the screen.

Object attributes and their values

Selection conditions may comprise attributes of two types - built-in and custom ones. 
Built-in attributes are mainly geometrical characteristics of objects. Their names begin 
with symbol «$». Custom attributes are names of fields in attributive tables linked with 
layers of vector objects. 

Built-in object attributes

Polylines (Polygons)

$VrtCnt number of vertices in polyline number

$Length polyline length number (project units)

$Area polygon (closed polyline) area number (project units)

$Winding line winding in percents number

$Z elevation value number

$Closed polyline closure yes/no

Points

$PointSize point size number (mm on the 
paper)

$BlockName name of the built-in point type set of point types

$Z elevation value number

Blocks

$BlockName block name set of blocks in the 
project

$Angle rotation angle of the block number (degrees)

Circles

$Radius circle radius number (project units)

Text

$Height text height number (mm on the 
paper)

$Align type of text align set of values

$Style name of text style set of styles in the 
project

$Angle rotation angle of a text string number (degrees)

$String text string symbol string
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Custom attributes

Types and names of custom attributes depend on types and names of fields in attributive 
tables connected with different vector layers. 

As a rule, they are in use for selection of one-type objects belonging to the same layer. 
Nevertheless, you may select objects having an attribute of name and type common for 
several layers. 

If a domain of possible values is specified for the attribute chosen for object selection, 
the Value field contains the list of possible values.

Moreover, if possible values in the attribute domain are correlated with text pseudonyms, 
just these pseudonyms will be represented in the list. 

Conditions of attribute-based selection

Logical operations that form a selection condition depend on the attribute type.

The Condition field contains a list of logical operations applicable to the selected attribute. 
The following operations are provided: 

•	 equal / not equal;
•	 less / not less;
•	 greater / not greater;
•	 multiple;
•	 empty / not empty;
•	 like / not like;

The «multiple» condition is accessible for numerical values only, and the «like» condition 
- for text strings.

Comparison operations («less» - «greater») are inaccessible for domain-restricted 
attributes. Instead, the «Another» operation is provided for selection of objects with 
«incorrect» attribute values that do not belong to the domain. Such objects may appear 
at data import as well as copying or transfer of objects to another layer.  

All the operations except «empty» and «another» require filling of the Value field.

Topology Editor 

This tool is designed for forming of topological links between objects as well as  correction 
of their vertices or insertion points. Within the capture distance of the cursor, it works 
on all objects of visible layers at once. If vertices of several polylines and/or insertion 
points of several objects of several objects coincide, Topology Editor operates with them 
as with a single point.
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The program automatically starts the «Show polyline vertices» view mode when you 
select the tool. 

When an insertion point, an edge, or a polyline vertex gets into the snap distance of 
the tool, a pop-up prompting appears that contains information about the number of 
objects sharing this edge or vertex. 

If the «Auto-snap» mode is on, a special marker substitutes the cursor at object snapping 
for univocal pointing at the captured vertex, insertion point or position in the edge. 

Objects captured with Group Editor become highlighted in turn in a way common with 
other Editors. 

Group Editor  affects only objects belonging to visible (switched on) vector layers.

Parameter bar of Topology Editor

Parameter bar of Topology Editor

 Cleaning mode - pulls vertices to the specified location. At that, all vertices within 
the Cleaning radius will be substituted for one vertex and insertion points of objects  
will be moved to the specified position.

 Auto-snap - makes snap distance of the cursor about three times greater and shows 
snap points. The tool may snap insertion points, vertices, and the nearest (to the cursor) 
points in polyline edges. At snapping, the cursor changes its appearance.  

Editing methods

Move of vertices and insertion points

Click the vertex (insertion point) to snap it and then click its desirable position. Right 
click or Esc key allows you to refuse from move of the captured vertex.

If the vertex (an insertion point) is common for several objects, its move affects all 
relevant polylines and/or objects

Adding of vertices

Point at a polyline edge with the cursor. A new vertex will be added in the nearest 
position. If the pointed segment is common for several polylines, new vertices will be 
added to all of them. 

You may create a new vertex or a node by move of a polyline vertex or an object insertion 
point on an edge or vertex of another polyline, i.e. at object snapping.



Editing 11

Snapping method (forming of a node or a common vertex) depends on the rules specified 
in the Project -> Properties -> Topology dialog box. 

Vertex deletion

To delete a vertex (common vertex), click it with the mouse right button.

Topology cleaning mode

Click the button in the Parameter bar to switch on the Topology cleaning mode, and then 
click the point where to you want to move vertices of polylines and/or insertion points 
of vector objects. All vertices within cleaning radius will be substituted for a vertex at 
the specified point. Similarly, insertion points will be moved. 

Object deletion

Any operation on objects makes one of them selected (current). It may be deleted by a 
stroke of Tab or Del, without selection of another tool. Error and correction marks are 
special objects that may be deleted with the mouse right button. 

Additional features

Hold Shift or Ctrl pressed to change the way of snapping. The program will ignore 
specified topological rules and form only common vertices or nodes correspondingly.  

To transform a common vertex into a node, click it at pressed Ctrl key.

Hot key for selection of Topology Editor is «1» for normal mode and «2» for Topology 
cleaning mode.

Vector eraser 

This is the main tool designed for correction of «dense» lines generated by Autotrace 
Lines utility. Ordinary editing tools are ineffective for such lines. Their correction comes 
to four main operations:

•	 Deletion of large juts - small spikes may be ignored as they will be deleted with Line 
Form Optimization utility.

•	 End trimming - deletion of «hooks» and bends at polyline ends greatly improves 
effectiveness of line joining across gaps with Breakup Joining utility and pulling of 
line ends to the frame with Topology Correction utility. 

•	 Deletion of false joinings - it is often enough to erase a false joining for subsequent 
automatic sewing of line segments together. 

•	 Deletion of rubbish - do not try to delete all vector artefacts manually, no matter 
how easy the operation is. Raw Line Filtering utility does it much quicker. 
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Superfluity of vertices in «dense» lines enables you to correct them with not so great care 
and therefore quickly. Line form will be improved later.  

Parameter bar of Vector Eraser

Parameter bar of  
Vector Eraser tool

  Eraser shape - You may delete vertices and cut lines with a round or a rectangular 
marker. Corners of the latter enables you to make precise cuts in lines. 

Size - you may select any marker size in the range from 5 to 100 screen pixels, depending 
on the size and resolution of your screen and the scale of screen output comfortable for 
editing. As a rule, it is equal to 50-70 pixels. Smaller marker decreases effectiveness of 
editing. Use the mouse wheel to zoom in the project at sites where exact correction is 
necessary. 

Fix mode - when on, a single stroke of Shift or Ctrl makes a certain operation mode 
current. When off, the mode is active until you hold a corresponding key pressed.

Repeated stroke of the key returns the tool to the main (vertex deletion) mode.

 Video-demonstration - starts a video showing use of the tool. 

Editing modes

Vector Eraser can function in three modes indicated by the color of its cursor. Use Shift 
and Ctrl for mode selection:

•	 White - erases (deletes) vertices. Left click deletes all vertices getting inside the marker 
of the cursor. To delete several vertices in a row, keep the left button of the mouse 
pressed and pass the tool cursor over them. If you delete all vertices of a polyline in 
this mode, the line itself will be deleted;

•	 Blue - deletes vertices with line cutting. Hold Ctrl pressed and click the line you want 
to dissect. Line part within the marker of the cursor will be deleted;

•	 Red - one-touch deletion of objects. Keep Shift pressed and delete objects with the 
left button.

You may cancel deletion (dissection) with the right button of the mouse that works 
similar to the Undo command.

You may select the tool from the Edit menu or from Special toolbar. Hot key for selection 
is «Q».
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Polygonal Shears 

Boundaries of one or several polygons form the «cutting rim» of this tool. It correctly 
splits consistent linear - polygonal coverages. Objects in the cut off part may be selected 
or deleted automatically. 

The tool cuts off and deletes any vector data either within or outside user-specified 
polygons. For example, it may be used to delete ends of river lines that got inside polygons 
of lakes or to cut off everything outside the map sheet frame in a multi-sheet project.  

Cutting borders may be selected from existing polygonal objects or specified 
manually. To specify cutting borders, just input their vertices.

To select already existing polygons, hold Shift pressed and click any point within 
the polygon(s) with the arrow marker, which substitutes the cursor. 

Polygons may be also selected beforehand with Group Editor. They automatically 
become cutting borders when you «take» Shears.

Manual selection of several polygons with Shears is similar to selection with Group 
Editor - the first pointing includes a polygon into the group, and the second excludes 
it.  

When selected, adjacent polygons form a united cutting border. Objects will be 
dissected by their combined outer boundary. 

The tool does not affect the polygons selected to form cutting borders. 

Cutting borders may be edited by means of vertex adding, move, and deletion similar 
to editing of polylines.

You may specify a set of vector layers to be affected by the tool, otherwise Shears will cut 
objects belonging to all visible non-frozen vector layers. 

You may select the tool from the Edit menu or from Special toolbar. Hot key for selection 
is Alt-W.

Commands of Shears tool submenu

Submenu  
of Polygonal  Shears

•	 invert cutting borders
•	 delete the current border
•	 delete all cutting borders
•	 split and select
•	 split and delete
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Contextual menu of the tool is an icon bar you can open by a right click within the 
program working window. It consists of the following commands:

 Invert cutting borders - inverts the areas you have specified - polylines outside these 
areas will be selected/deleted after inversion 

 Delete the current border - deletes only the current (highlighted) cutting border. 
To make a polygon current, point it with the cursor. 

 Delete all borders - deselects all currently specified cutting borders.

 Split and select - the command splits polylines at the points of their intersection 
with the specified polygons and automatically starts the group editing mode. At 
that, polyline segments inside the specified areas becomes selected. 

 Split and delete - splits polylines just like the previous command does but deletes 
polyline segments inside the specified areas.

Parameter bar of Polygonal Shares

Parametet bar 
of Polygonal Shear tool

Selected layers - here you may form a list of layers that will be affected by the tool. If 
nothing is specified in this field, the tool cuts objects belonging to visible non-frozen 
layers. 

Camber Editor 

Camber Editor is one of most universal and constantly in use tools for line shape editing. 
It enables correction of any smooth curve just by several moves. The cumber it forms is 
smoothly connected with neighboring line segments.

The tool can modify common parts of different polylines in coordination (e.g., common 
boundaries of adjacent polygons).

Description of the tool

Line form editing starts with selection of the object (in the auto-selection mode usually). 
Click the mouse left button near the line where you want to form a camber (do not touch 
the line) and begin to move the cursor towards the line.   

Color of the captured line changes and three markers appear in the line. The central 
marker corresponds to the peak of future camber and two others indicate ends of the 
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line part being bent.

The farther is the cursor from the line when you start the operation the bigger is the 
camber radius and therefore the larger line segment will be modified.

Horizontal deviation of «pressure» vector enables you to form a asymmetrical S-shape 
camber. The longer is the vector, the larger is the camber.

You may change the direction of cursor moving to «pull» the line part rather than 
«push» it and thus to form a concavity.

Camber radius on the captured line may be changed with the mouse wheel.

Left click fixes the current camber. Right click or Undo command allow you to refuse 
from line alteration. 

Attention! Remember that Undo command by right click is not restricted by 
modifications made with Camber Editor and may cancel previous operations

It is recommended to switch off the auto-selection mode at editing of closely located 
lines. In that case you must click the line itself to make it current.

Switch on the Cohesion keeping deformation mode at editing of coincident parts of 
different lines. The number of such lines is unlimited. 

Parameter bar of Camber Editor

Parameter bar 
of Camber Editor tool

Selected layers - the tool interacts with polylines of all visible non-frozen layers by 
default but you may specify a list of layers that contain objects subject to editing to avoid 
accidental capture of irrelevant lines. 

 Auto-selection - activates object capture by «pressure» of the tool marker. The 
next objects becomes available for selection after you have completed editing of 
the previous one. Then you just move the cursor to the new start position, click 
the mouse left button, and start «to press» on the object.  

Approximation precision - controls precision of smooth cumber transformation into 
polyline vertices similar to the case of tracing tools and Line Form Optimization utility.

 Single-object deformation - only one polyline may be edited at once in this mode. 
Other lines coinciding with the line part being deformed will be ignored.

 Cohesion keeping deformation - common segments of the captured and other 
lines will be modified together. 

 Parameters - opens the Camber Tool Settings dialog box.
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Parameters of Camber Editor

Camber Editor Settings 
dialog box

Maximal distance of action - limits the tool’s radius of action and thus prevents accidental 
alterations of captured objects beyond the working window.

Active polyline display color - allows color selection for representation of the current line. 

Adhesion corrector 

Automatic vectorizing always generates a lot of artefacts. These are  «adhesions» of 
neighboring lines, «bridges», «branches», etc. A great share of such objects can be deleted 
with Raw Line Filtering utility, and the remains usually require manual editing. 

Actually, Corrector and the utility fulfill the same operations but the tool allows you to 
select the way of artefact processing. 

Deletion of «branches», «strokes», or «loops» takes just artefact pointing. To delete an 
«Х-joint», hold Shift down otherwise it will be regarded as a «bridge» or an «adhesion».

Processing of «bridges» and «adhesions» is interactive.

The program suggests the way of correction at artefact selection. To change it, move the 
cursor along the artefact (adhesion) or  crosswise it (bridge).

Mouse wheel rotation changes the distance between closing line segments at deletion 
of an «adhesion» or improves line bends adjacent to a «bridge». Left click to complete 
artefact processing.

Stroke Esc to interrupt the operation or click the mouse right button to cancel previous 
corrections. Similar to Vector Eraser and Camber Editor, right click is an exact equivalent 
of Undo command.

Parameter bar of Adhesion Corrector

Parameter bar  
of Adhesion Corrector tool

Line width - width of raster lines in the source image. This parameters helps to calculate 
the length of undamaged line parts adjacent to the artefact. Big values correspond to 
long defect segments.
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Displaying color - allows color selection for representation of supposed correction.

You may select the tool from the Edit menu or from Special toolbar. Hot key for selection 
is Alt-X.

Polyline Resizing / Shifting 

Vector contours not always correspond to raster ones in the source map or  space photo. 
For example, small closed contours drawn with rather heavy lines tend to «collapse» and 
become even smaller at vectorizing.

Correction of such contours requires their proportional stepwise expansion (or 
contraction sometimes).  

Shift of polylines is another way of the tool application, at vectorizing of «double» lines 
as a rule. For example, if a road is represented by two lines in the map, you may vectorize 
one wayside, and then move it the central position.

The step of expansion / shift measured in pixels may be specified in the corresponding 
field of the Parameter bar. 

Object move direction depends on right (expansion) or left (contraction) click. An 
unclosed polyline moves to the left (considering line direction) at left click and to the 
right at right click. 

Several objects at once may be selected for the operation with Group Editor or with the 
tool itself. To modify all objects of the group, point at any of them. 

To change or form the group, hold Shift down and click objects with the mouse left 
button. Repeated left click excludes an object from the group. 

When the group is ready, release Shift and start the operation.

First stroke of Esc deselects object(s) and the second quits the tool. 

Parameter bar of Polyline Resize / Shifting

Parameter bar 
Of Polyline Resize / Shifting tool

Parameter bar of the tool is is very simple - only step of displacement may be specified 
here (measured in pixels of the image). Shift direction and expansion / contraction 
depend on the mouse left or right button.
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Bookmarks - positioning tool
The tool provides convenient means to memorize the current position of the working 
window and the scale of screen output, i.e. to make a bookmark. In future, you will be 
able to open the marked project part instantly.

There may be several bookmarks in the project. You may jump from one of them to 
another, to and fro, in the order of bookmark forming.

Bookmarks are not shown during the work but short blinking of the project frame 
confirms bookmark forming.  

The following commands are provided for tool control:

•	 make a bookmark Ctrl+F5;
•	 jump to the previous bookmark F5;
•	 jump to the next bookmark Shift+F5;
•	 delete the current bookmark and jump to the next one Alt+F5;
•	 delete all bookmarks.

If the current working window overlaps the current bookmark and you want to jump 
to the next one, the command restores the scale and position of the current bookmark 
first. Input the command again to shift the working window. 

Bookmarks were one of the first tool designed for marking of project areas and working windows 
positioning on them. It is reasonable now to use Inspector instead of Bookmarks at total check 
of the project. 
Besides, any object may be attributed to the special vector layer (_ERRORS_) to mark a doubtful 
situation. It is convenient to use circles. Hot keys «F» and «V» provide automatic positioning 
on objects of this layer. 
Another way of quick review is to create an additional layer, to attribute doubtful objects to 
it and to make them marked with the help of Group Editor. Marked Object Navigation view 
mode enables quick positioning of the working window on them. 

Inspector

Vectorizing is a chaotic process in essence. Correction of one object prompts the operator 
to correct the neighboring one, and so on.

On the other hand, the entire project field should be  reviewed in order, without omissions 
and senseless iterations.  

Our Inspector tool was designed for this purpose. In general, the process is organized 
in the following way:
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•	 Choice of inspection zone. It may be of an arbitrary form, but the vector frame of 
the project is mostly in use. The entire project field is the inspection zone by default;

•	 Choice of review scale. This parameter together with the size of your project control 
the size of the project part represented in the working window - so called «frame».  
User-specified overlapping of neighboring frames ensures total review without 
omissions near frame borders;

•	The tool divides the entire inspection zone into frames that you may review in order. 
Press «4» to proceed to the next frame and «5» to return to the previous one.

•	The tool allows you to overstep the limits of the current frame and/or to change the 
scale at editing. Shift to the next frame command restores the scale and position of 
the current frame first. Actual shift happens when you repeat the command.

You may change inspection scale or frame overlap even after partial execution of review 
with the help of Continue button. The program recalculates partition of inspection zone 
into frames and you continue the operation without an omission or repeated review.

Inspection zone specifying

Working zone of Inspector coincides with the project field by default but it is not always 
convenient. 

First, your project may be based on an image with spacious edge information that does 
not require review.

Second, project field’s region of interest may be non-rectangular. For example, map sheets 
may be trapezoid or your project may comprise several maps.

The most convenient way to specify the zone of inspection is to point at the vector frame 
of the project (or several frames if the projects consists of several map sheets).

Another often situation that requires ordered control is the joining zone of adjacent 
sheets. In that case, use inspection trajectory (along a line) instead of inspection zone.

Submenu of the tool enables you to specify review parameters.

Commands of Inspector tool submenu

Additional menu 
of Inspector tool

•	 rectangular zone
•	 arbitrary zone
•	 specify borders
•	 delete zones
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Contextual menu of the tool is an icon bar you can open by a right click within the 
program working window. It consists of the following commands:

 Rectangular zone

You may specify a rectangular inspection zone in this mode.

 Arbitrary zone

You may specify an arbitrary inspection zone in this mode.

 Specify borders

The current border of inspection zone will be changed when you complete setup. 

 Delete zones

Cancels specified inspection zones.

Parameters of Inspector tool

Inspection Setup 
dialog box

Review direction group - select convenient direction of working window shift at review.  
Horizontal and vertical zigzag are mostly in use.

Inspection scale - specify the scale of frame. It does not impede arbitrary zoom at review. 
Scale change does not derange the order of inspection zone passing. 

Frame overlap - specify the size of frames’ mutual overlapping, both horizontal and 
vertical. Project area within the overlapping band will be represented in both frames.  
It helps the operator to «keep orientation» at frame change.

Always display the inspection area border - borders of the inspection zone remain visible 
when you close the Inspection Setup dialog box.

Skip frames without visible vector objects - automatic jump over frames without visible 
vector objects.

Auto-hide this window - if on, the dialog box will be minimized when you move the 
cursor outside it to specify the border of the inspection zone. 
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Start - closes the dialog box and shows the first frame of the inspection zone. Review 
always starts from the upper left corner of the zone or the first point of the specified  
trajectory.

Continue - if Inspection scale and/or Frame overlap parameters are changed during 
inspection, the program recalculates partition of the inspection zone into frames.   
Continue button enables you to resume the operation without omission or iteration. 
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